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[bookmark: _Toc33803619]Introduction  
Accessibility means giving people of all abilities opportunities to participate fully in everyday life and is achieved by understanding needs and removing barriers. 
Accessibility is a powerful concept – it improves our communication, brings more people together, and increases our competitive advantage. 
The Ontario Public Service (OPS) endeavours to demonstrate leadership for accessibility in Ontario. Our goal is to ensure accessibility for our employees and the public we serve in our services, products and facilities. A broader range of people will be able to work for the OPS if we are a more accessible organization, and more people will be able to access our services. 
Have you ever realized that not everyone receiving your documents can read and understand them as well as you think? Most of us do not consider people with disabilities when creating documents. Making documents accessible is a shared responsibility by all employees at all levels of the organization. 
This guide is a primer to help you understand the concepts behind creating accessible documents. It describes the tools and strategies that we can use to enhance the accessibility of information that we produce using word processing software (e.g., Word, PowerPoint, Outlook). Note that this document is meant to support—not replace—training.  
In the appendices, you’ll find more links to more resources, including:
· tools and training for basic and more technical content
· legislation and OPS Policies and guides
· OPS and ministry contacts
For more technical content/documents, there are additional considerations and potential exceptions, depending on the format of the content and the software used to create it. None of the advice that follows is set in stone – you must use your judgement and apply the advice where it makes sense to do so. 
However, if you keep the concepts that follow in mind as you design your products, we believe that you will reach a wider audience and create better, more usable documents.


[bookmark: _Toc396484668][bookmark: _Toc33803620]Font family
Choose sans-serif fonts
Approved OPS typefaces are sans serif fonts and the common default font is Arial. Some of the most well-known sans serif typefaces include Helvetica, Arial, Verdana, Calibri, Futura and Franklin Gothic. This style of typeface lacks strokes at the ends of letters (hence “sans” serif).
Avoid complicated, decorative or handwriting fonts
[image: ]
Figure 1- Serif vs san serif fonts
[bookmark: _Toc33803621]Font size
Choose large text, preferably between 12 and 16 points 
The size of the font is a fundamental factor in legibility. Font size 12 is recommended.
Avoid font size 11 or smaller
Can you see the difference in the samples below?
Font Size 10 or less is not accessible
Font size 12 recommended for body text
Font Size 14 recommended for headings
Font Size 16 recommended for headings or large print
Note: Font size appears different between font families. This guide is based on the Arial font.  If using sans-serif fonts other than Arial, use Arial as the base for determining appropriate font size.  For example:
This is Arial 12 point
This is Calibri 12 point 
This is Verdana 12 point
[bookmark: _Toc33803622]Bold, italics, and underline
Limit the use of bold
Bolding certain words and phrases can be used to make them stand out from surrounding text. However, whole paragraphs of text set in bold type are hard to read and should be avoided. 
Limit use of bold formatting to titles, headlines or key words and short phrases.
Avoid italics
The italic character style is more difficult to read than regular fonts, mainly due to the output of angled characters on a digital screen with poor resolution. 
Italics should be limited based on requirement for its application, for example, use of italics for citations in legal documents or Latin names of species. As a general rule, avoid italics where possible.  
Quick tip: If you are hyperlinking to legislation/regulations – you do not have to italicize. 
Avoid underlining
Only use underlining for links such as email addresses and web pages. Underlining interferes with lower case letters. Do not use underlining for emphasis. 
[bookmark: _Toc33803623]Links
Use descriptive hyperlinks 
A meaningful hyperlink uses descriptive text that should make sense when read out of context. 
Avoid non-descriptive link phrases such as: “click here”, “here”, “more”, “read more” or “info”. Such phrases are unnecessary, even if they precede a more meaningful phrase. For example, a link that says, "click here to access today's weather" can be shortened to "today's weather." 
Screen readers can create a list of links. Using descriptive hyperlinks helps people who use screen readers understand what the links are connected to.
Add the URL 
In addition to making your hyperlinks descriptive, it is recommended to provide the full URL in brackets after the live link, in a footnote or in an appendix. This is particularly helpful to users who print your document. 
DO: 		Go to Paciello Colour Contrast Analyser to download the application. 
DON’T: 	Click here to download Paciello Colour Contrast Analyser

OPTIONAL: 	(URL: www.paciellogroup.com/resources/contrastanalyser/)
Note: the URL above is quite long and causes a ‘warning’ in the Accessibility Checker. Warnings flag potential issues for users. In this case, use your judgement to decide if you think the URL is enhancing or a diminishing the usability of your document. This will help you decide whether to include or remove the URL, move it to a footnote or an appendix, in response to the warning. 
Below is an example of how a screen reader produces a list of non-descriptive links:
[image: ]
Figure 2 - Jaws - List of non-descriptive links
[bookmark: _Toc33803624]Hyperlink universal colour
Choose the international standard of a blue font, underlined
If your link appears in a different colour, ensure that it is underlined and that the colour is fully accessible. For email address and webpage links, it is better to use the international standard blue font (RGB value 0-0-255).
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Do not rely on colour
People see colour in different ways. To enhance the readability of your documents, never rely on colour alone to transmit information. If you do use colour, make sure the document still makes sense even if you couldn't see the colours. 
For example, if a red triangle denotes a project milestone, use a green circle for project dependencies, so that colour is not the only indicator.
Choose high contrast colours
People with low vision or colour blindness may not be able to read text that does not have a high degree of contrast with the background. Choose a dark background with a light font or vice-versa. 
Avoid pale blue text
As eyes age, the first colour that people notice a degradation in sight with is pale blue. This happens because the cones in your retinas that detect colour start to lose some of their sensitivity with age. 
What does high contrast look like?
Use a minimum 4.5:1 colour contrast ratio between the background and the foreground. Black text on a white background provides the best contrast. The higher the contrast between the background and the foreground, the more legible the document. For large text (14 pt. bold or 18 pt. non-bold) use at least a 3:1 colour contrast ratio. 
You can test your document contrast by printing in black and white or gray scale to see if it is legible. You can also use a tool, like Paciello Colour Contrast Analyser*, to check colour contrast. 
	Test Number
	Contrast Ratio
	Result

	Test 1
	21:1
	Pass

	Test 2
	21:1
	Pass

	Test 3
	19.56:1
	Pass

	Test 4
	15.27:1
	Pass

	Test 5
	14.73:1
	Pass

	Test 6
	10.37:1
	Pass

	Test 7
	7.01:1
	Pass

	Test 9
	7.24:1
	Pass

	Test 8
	3.95:1
	Fail

	Test 10
	2.0:1
	Fail

	Test 11
	2.18:1
	Fail

	Test 12
	1.4:1
	Fail


Figure 3 - Colour contrast test samples
[bookmark: _GoBack]* Note: To install the Paciello Colour Contrast Analyzer to your computer “free-of-charge”, complete a ONRequest (formally S.O.D.O) or contact the OPS IT Service Desk at 1-888-677-4873.
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Choose a combination of upper and lower case letters
The ascenders and descenders found in lower-case letters provide word shape, causing mental reading clues to speed up the process of reading. 
Avoid sentences written in all upper case
Look at the difference and notice which one is easier to read:
[image: ]
Figure 4 - Sample of differences
[bookmark: _Toc33803627]Heading styles
Visual readers engage their eyes for cues to identify headers by scanning pages for text of a larger size or a different colour/font face. However, screen reader users are not able to see these visual changes, so increasing the font size or colour is not a sufficient cue.
Use heading styles to create structure 
Headings are a type of paragraph style used to create consistent formatting and help users to navigate the document. Headings act as tags that assistive technology or other devices can interpret and provide as information to users.  
Best practice: Use sequential headings, for example, use Heading 1 for the document’s title, Heading 2 for main headings, heading 3 for subheadings.
You can see your document headings by going to View>Navigation Pane in the ribbon.
[bookmark: _Toc352230888][bookmark: _Toc352230991][bookmark: _Toc352231011][bookmark: _Toc352231029][bookmark: _Toc352235122][bookmark: _Toc352246429][bookmark: _Toc352655295][bookmark: _Toc352655340][bookmark: _Toc352655358][bookmark: _Toc352657066][bookmark: _Toc352657088][bookmark: _Toc352676122][bookmark: _Toc352761032][bookmark: _Toc352761302][bookmark: _Toc352761462][bookmark: _Toc352831228][bookmark: _Toc352831274][bookmark: _Toc352831321][bookmark: _Toc352831345][bookmark: _Toc352831401][bookmark: _Toc352831435][bookmark: _Toc352831610][bookmark: _Toc352831691][bookmark: _Toc352831711][bookmark: _Toc352833842][bookmark: _Toc352854315][bookmark: _Toc352854453]Add a table of contents
Once you’ve tagged your document with headings, you can easily generate a table of contents. A table of contents is essentially a list of document headings, which act as hyperlinks for users and screen readers to navigate through your document. 
[bookmark: _Toc33803628]Spacing
Adjust paragraph spacing
Adjust the spacing before or after a paragraph, usually by the height of your font size. This can be set automatically using styles and accessed via the paragraph setting in your ribbon. For example, if you are using a 12 pt. font, your paragraph spacing should be 12 pt. 
[bookmark: _Toc425760784]Avoid using hard returns (enter) or soft returns (shift enter) to create spacing
If you hit enter twice or more times to create spacing between paragraphs, a screen reader will interpret the enter as a new paragraph with no text. The screen reader will read the word blank /new line out loud for every blank line. Instead, use the paragraph spacing options to create white space.
Adjust line spacing
[bookmark: _Toc352228760][bookmark: _Toc352228787][bookmark: _Toc352230886][bookmark: _Toc352230989][bookmark: _Toc352231009][bookmark: _Toc352231027][bookmark: _Toc352235120][bookmark: _Toc352246427][bookmark: _Toc352655293][bookmark: _Toc352655338][bookmark: _Toc352655356][bookmark: _Toc352657064][bookmark: _Toc352657086][bookmark: _Toc352676120][bookmark: _Toc352761030][bookmark: _Toc352761300][bookmark: _Toc352761460][bookmark: _Toc352831226][bookmark: _Toc352831272][bookmark: _Toc352831319][bookmark: _Toc352831343][bookmark: _Toc352831399][bookmark: _Toc352831433][bookmark: _Toc352831608][bookmark: _Toc352831689][bookmark: _Toc352831709][bookmark: _Toc352833840][bookmark: _Toc352854313][bookmark: _Toc352854451]When the space between lines is open, it is better to read for people with visual impairments. Typically, a minimum of 1.15 lines is recommended. Note: This is not related to font size like paragraph spacing.
[bookmark: _Toc33803629]Objects
Images, tables, pictures, charts, logos are considered objects. 
Add alternative text (Alt Text)
Alt (alternative) text is a description that is added to an object to help someone using assistive technology understand the purpose of the graphic. Most experts agree that alt text should be kept to a maximum of 125 characters, so be pithy and informative when you apply alt text to a shape, picture, chart, table, SmartArt graphic or other object.
· Access the Edit alt text command in the image properties menu (right-click on image or SHIFT+F10) or add the alt text command to your quick access toolbar
· Don’t use the ‘Generate a description for me’ feature 
· Avoid using the ‘Mark as Decorative’ feature in Word as it currently does not work as intended; instead, ensure all images, including decorative ones, have a meaningful alt text description
Avoid using repetitive titles and descriptions
DO: 	Title: Logo of Ontario 
Description: The trillium is the official symbol of the Government of Ontario 
DON’T: 	Title: Logo of Ontario  
Description: Logo of Ontario
Avoid using floating images or images that are for decoration only
Floating images are layered over top of text and not inline with the text. Avoid using images of text, where possible (logos are an exception to this rule).
[bookmark: _Toc352228757][bookmark: _Toc352228784][bookmark: _Toc352230883][bookmark: _Toc352230986][bookmark: _Toc352231006][bookmark: _Toc352231024][bookmark: _Toc352235117][bookmark: _Toc352246424][bookmark: _Toc352655290][bookmark: _Toc352655335][bookmark: _Toc352655353][bookmark: _Toc352657061][bookmark: _Toc352657083][bookmark: _Toc352676117][bookmark: _Toc352761027][bookmark: _Toc352761297][bookmark: _Toc352761457][bookmark: _Toc352831223][bookmark: _Toc352831269][bookmark: _Toc352831316][bookmark: _Toc352831340][bookmark: _Toc352831396][bookmark: _Toc352831430][bookmark: _Toc352831605][bookmark: _Toc352831686][bookmark: _Toc352831706][bookmark: _Toc352833837][bookmark: _Toc352854310][bookmark: _Toc352854448][bookmark: _Toc396484672][bookmark: _Toc425760771][bookmark: _Toc425762115][bookmark: _Toc33803630]Alignment
[bookmark: _Toc425760773]Choose left alignment
Align text to the left margin and do not justify it. This makes it easier to find the start of the next line and keeps spacing between the words even. 
When inserting an image or other object within text, choose “In Line with Text” so the text will be placed above or below the image. 
[bookmark: _Toc33803631][bookmark: _Toc396484681][bookmark: _Toc425760792][bookmark: _Toc425762126][bookmark: _Toc352230889][bookmark: _Toc352230992][bookmark: _Toc352231012][bookmark: _Toc352231030][bookmark: _Toc352235123][bookmark: _Toc352246430][bookmark: _Toc352655296][bookmark: _Toc352655341][bookmark: _Toc352655359][bookmark: _Toc352657067][bookmark: _Toc352657089][bookmark: _Toc352676123][bookmark: _Toc352761033][bookmark: _Toc352761303][bookmark: _Toc352761463][bookmark: _Toc352831229][bookmark: _Toc352831275][bookmark: _Toc352831322][bookmark: _Toc352831346][bookmark: _Toc352831402][bookmark: _Toc352831436][bookmark: _Toc352831611][bookmark: _Toc352831692][bookmark: _Toc352831712][bookmark: _Toc352833843][bookmark: _Toc352854316][bookmark: _Toc352854454][bookmark: _Toc396484679][bookmark: _Toc425760790][bookmark: _Toc425762124]Tables 
Avoid using tables to provide structure 
Use tables to organize data – not to format your document. Tables are difficult to read for people who have a visual disability. Remember to avoid merged cells, nested tables and empty cells, rows and columns. 
To make an accessible table ensure you specify the header row and ensure ‘repeat header row’ is selected and use alternative text to describe the table. In Word - include table bookmarks. 
[bookmark: _Toc33803632]Lists
Avoid manually numbered lists or using characters like dashes 
Format lists by using automatic bullets or numbering. Remember that bullets are for unordered items; numbered lists are for counted or ordered items. Some bullets cannot be read by assistive technology, like the hollow bullet – use solid circle/dots or squares. 
DO: 	
1. Description: The trillium is the official symbol of the Government of Ontario 
DON’T: 	
· Description: The trillium is the official symbol of the Government of Ontario 
[bookmark: _Toc33803633]Watermarks
Avoid using watermarks
Watermarks make the document difficult to read for persons with impaired vision or cognitive disabilities. If you need to highlight a document as “confidential” or “draft”, include the words in the header, footer or filename of the document.
[bookmark: _Toc33803634]Language setting
Some screen reader technologies have the ability to switch to the appropriate spoken language by identifying the language of the document. Using the correct language setting in Word allows the screen reader to correctly pronounce the content in the document. 
To see what language your document is set in, refer to the status bar at the bottom of your  Word document e.g., English (Canada).
[bookmark: _Toc33803635]Plain language
Plain language is a way of presenting information so that it makes sense and is easy to read the first time. All readers, and especially people with cognitive, neurological, and developmental disabilities, will benefit if you keep the language simple in your documents.
Use language your audience knows and feels comfortable with
Use short sentences and paragraphs
Use simple sentence structure and grammar
Use simple everyday words instead of technical jargon
Use an active voice
[bookmark: _Toc33803636][bookmark: _Toc352230891][bookmark: _Toc352230994][bookmark: _Toc352231014][bookmark: _Toc352231032][bookmark: _Toc352235125][bookmark: _Toc352246432][bookmark: _Toc352655298][bookmark: _Toc352655343][bookmark: _Toc352655361][bookmark: _Toc352657069][bookmark: _Toc352657091][bookmark: _Toc352676125][bookmark: _Toc352761035][bookmark: _Toc352761305][bookmark: _Toc352761465][bookmark: _Toc352831231][bookmark: _Toc352831277][bookmark: _Toc352831324][bookmark: _Toc352831348][bookmark: _Toc352831404][bookmark: _Toc352831438][bookmark: _Toc352831613][bookmark: _Toc352831694][bookmark: _Toc352831714][bookmark: _Toc352833845][bookmark: _Toc352854318][bookmark: _Toc352854456]Accessibility checker panel
The Accessibility Checker is a tool to help authors identify accessibility issues in a document. This tool is now available in the Review tab in the ribbon bar for ease of access. Use this tool every time! 
The tool identifies three categories of issues that may prevent some users from accessing the content of a document: Errors, Warning and/or Tips. Warnings and Tips may still appear in the Accessibility Checker task pane after they have been corrected. 
Best Practice: Open the Accessibility Checker when you open your document so you can check for and address any issues as you go. You can add this tool to your Quick Access Toolbar: File>Options>Quick Access Toolbar>All commands>Add the Accessibility checker. 
[image: ]
Figure 5 - Accessibility Checker in Word O365
Note: this tool should be used in conjunction with a manual check and assistive technology testing (e.g., JAWS) as it will not check things like: 
Font selection and font size
Appropriate white space and line spacing 
Appropriate selection of heading styles
Repeated blank characters
Hyperlink text is meaningful
Non-accessible bullets e.g., a hollow bullet
Colour contrast
Alt text is meaningful
Spelling and grammar, etc.
Always manually review these elements in your document, in addition to using the Accessibility Checker Tool. 
Did you know: your Outlook also has an Accessibility Checker. The checker can be accessed from a button in the Review tab on the ribbon
[image: ]
Figure 6 - Accessibility Checker in Outlook
[bookmark: _Toc33803637]Accessible emails
Email is the most common form of communication among employees in the OPS, so it is important to make emails as readable as possible. In addition to all of the advice provided above, remember to:
· avoid using backgrounds
· avoid using pictures of text to convey important messages e.g., retirement notices, charitable campaigns, etc.
· insert the content in the body of the email rather than attaching a document
· add attachments to the ‘attachment field’, not directly into the body of the email
· use HTML style rather than plain text to ensure proper structure
· ensure your signature block is accessible and contains an active offer, for example:
Please Note: As part of providing accessible customer service, please let me know if you have any accommodation needs or require communication supports or alternate formats.
[bookmark: _Toc33803638]Resources – getting started
These following resources will help you learn more about digital accessibility at source. 
OPS digital accessibility training and resources
The I&IT Accessibility Centre of Excellence (ACOE) provides numerous resources (instructor led, self-directed, and video tutorials) for creating accessible documents for common desktop applications. 
· Check out the ACOE’s testing resources – they will help you gain a better understanding of how to test documents and websites, as well as outline some testing tools available
· OPS digital accessibility training and resources: Check out this comprehensive suite of training, tools and resources to support you in creating accessible electronic documents, web content and digital services
Make it Accessible Learning Pathway (Ministry of Natural Resources & Forestry intranet): designed to guide you to learning tools and resources to help further build the skills you need to format documents properly and to understand what it means to meet accessibility standards, so your digital content and documents are accessible@source 
Website accessibility 
GO-ITS 23 Government of Ontario Web Standard
[bookmark: Three]WCAG 2.0 Level AA standards
Understanding varying needs and potential barriers
Education & Awareness – Disabilities
Ontario Digital Standard - designing inclusively
OPS Accessibility Review Tool
OPS Inclusion Lens – Disability Dimension
[bookmark: _Toc33803639]Resources – Legislation and Policy
OPS Guides:
A Guide to Accessibility Directives and Policies in the Ontario Public Service
MNRF Guide to Active Offer - this reference tool helps staff respond to requests for alternate formats or communication supports
Legislation:
Canadian Charter of Rights 
UN Convention on the Rights of Persons with Disabilities
(Canada signed the Convention in 2007 and it was ratified in 2010)
Ontario Human Rights Code
Accessibility for Ontarians with Disabilities Act, 2005 on e-laws
Integrated Accessibility Standards Regulation on e-laws
Ontarians with Disabilities Act, 2001 on e-laws
External resources:
Registered Graphic Designers – A Practical Handbook on Accessible Design 
Clear Print Guide – Canadian National Institute for the Blind
[bookmark: _Toc33803640]Resources – Key Contacts
Accessibility Leads are key in helping ministries meet accessibility standards under the AODA as well as accessibility planning under the 2017–2021 OPS Multi-Year Accessibility Plan (MYAP). 
Ministry Web Coordinators and Cluster Web Coordinators support program areas with their website accessibility and post AODA compliance reports to the OPS Website Database. Find out if your website and its content are already meeting WCAG 2.0 AA standards. To learn more, get in touch with your respective ministry or cluster Web Coordinator.
I&IT Accessibility Centre of Excellence (ACOE) strives to empower OPS staff to create accessible digital products by providing trusted expertise, how-to advice, resources, and leadership in an evolving digital I&IT environment.  
Supply Chain Ontario provides information on procurement policy and provides tools and resources to support you as you consider the issues of inclusion, diversity, equity and accessibility in your procurement documents and processes.
LearnON is an enterprise-wide Learning Management System (LMS) for all OPS employees – browse the catalogue for accessibility courses. 
Ministry for Seniors and Accessibility (MSAA) supports accessibility for people with disabilities by implementing the Accessibility for Ontarians with Disabilities Act and by removing and preventing barriers in everyday life. 
OPS Accessibility Office in MSAA plays a central leadership role in developing the strategy and communicating and implementing key enterprise-wide initiatives to drive change. It ensures that the OPS is equipped to be accessible and inclusive, in all its policies, programs, and services. 
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[bookmark: _Toc33803642]Key hyperlinks and associated URLs
All links in this document have been created with meaningful text. The Uniform Resources locator (URL) for key information, legislation, and contacts is published below to be available to persons who print this document. The URL addresses that are spelled out are not active links to avoid confusion of presenting duplicate links.
Accessibility Leads: https://intra.ontario.ca/tbs/lnclusion-accessibility-and-mentoring-leads
Cluster Web Coordinators: http://intra.net.gov.on.ca/wiki/Cluster_Web_Coordinators
Education & Awareness – Disabilities: https://intra.ontario.ca/ops/understanding-disabilities
GO ITS 23 Standard: https://www.ontario.ca/document/go-its-23-government-ontario-web-standard
Guides:
IASR: https://intra.ontario.ca/wordpress/uploads/2015/02/A-Guide-to-the-Integrated-Accessibility-Standards-Regulation.pdf
OPS accessibility directives/policies: https://www.ontario.ca/page/ontario-public-service-policies-make-accessibility-work
A Practical Handbook on Accessible Design:  http://www.rgd.ca/database/files/library/RGD_AccessAbility_Handbook.pdf
Clear Print Guide: https://www.cnib.ca/en/sight-loss-info/blindness-at-work/creating-inclusive-workplace?region=on
I&IT ACOE:
https://intra.ontario.ca/ops/education-training
https://intra.ontario.ca/ops/testing-for-accessibility
LearnON: https://intra.ontario.ca/tbs/learnon-2
Legislation:
Canadian Charter of Rights: http://laws-lois.justice.gc.ca/eng/Const/page-15.html
UN Convention on the Rights of Persons with Disabilities: https://www.un.org/development/desa/disabilities/convention-on-the-rights-of-persons-with-disabilities.html
Ontario Human Rights Code: http://www.e-laws.gov.on.ca/html/Statutes/English/elaws_statutes_90h19_e.htm#BK1
AODA: http://www.e-laws.gov.on.ca/html/statutes/english/elaws_statutes_05a11_e.htm
IASR: https://www.ontario.ca/laws/regulation/110191
ODA: http://www.e-laws.gov.on.ca/html/statutes/english/elaws_statutes_01o32_e.htm
MIA Learning Pathway: http://intra.apps.mnr.gov.on.ca/makeitaccessible/learn-more/
Ministry Web Coordinators: http://intra.net.gov.on.ca/wiki/Ministry_Web_Coordinators
MSAA: https://www.ontario.ca/page/ministry-seniors-accessibility
1. Ontario Digital Standard - designing inclusively: https://www.ontario.ca/page/build-ontario-government-services#section-3
OPS Accessibility Review Tool: https://intra.ontario.ca/ops/accessibility-review-tool#art-reference
OPS digital accessibility training and resources: http://intra.accessibilitytesting.cyssc.gov.on.ca/ComplianceSheriff_ACOE/Training/Graduated-Training-Curriculum/digital-accessibility-training.html
OPS Inclusion Lens – Disability Dimension: https://intra.ontario.ca/tbs/disability
Paciello Contrast Analyzer: https://developer.paciellogroup.com/resources/contrastanalyser/
S.ODO: http://intra.servicedesk.its.gov.on.ca/Solutions/SelectCategory/S.ODO/S.ODO
Supply Chain Ontario: http://intra.ops.myops.gov.on.ca/cms/tiles.nsf/(vwReadPagesByRefId_Content)/scm2006.12.18.13.17.42.PG4_page?open
WCAG: http://www.w3.org/TR/WCAG/
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